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Introduction.

You’ve captured an image with your digital camera.

–or–

You’ve scanned a print or negative with your scanner.
Now what?

The answer is output. Output refers to the final destination for
your digital capture. For some, output might mean an inkjet
print to hang on the wall. Others may want to send a picture
to a relative in another country via e-mail. Maybe you’re not
sure what you want to do with your images but want them
ready in digital form for use later. In this case, you need to
organize and store them, safely and efficiently, and that means
output to a disk of some sort. Perhaps output to you simply
means saving your image in a particular file format.

We’ll cover output extensively later in your Course, 
including information on using your images in a variety of
ways, from Web site design to desktop publishing. Before
we cover those advanced topics, however, let’s look at these
basic output methods – saving your images to disk, 
archiving your images and printing your images.
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Saving Your Images.

As we discussed earlier in your Course, digital cameras will save
your pictures in a variety of different types of file formats—
JPEG and TIFF for example. If you are working with a digital
camera, in essence your decision on how to save your images
has happened long before you transferred them into your 
computer. You made the decision to save your pictures in one
of these formats right in the camera. 

In the next Unit, when we begin our study of Photoshop, we’ll
be showing you how to use Adobe Photoshop to convert your
digital camera photos or your scanned images from one file 
format to another. For now, once you have transferred your
camera’s images into your computer, you need to determine
where to keep them and whether or not you want to print
them and the best way to do so.

Images that are scanned also need to be saved in one of several
popular file formats. You have to make the exact same decisions
with regard to file type with a scanned image that you do with
an image captured with a digital camera. For instance, you may
choose to save your scanned image in an uncompressed TIFF
format, which would give you the option of enlarging or 
reducing the image without loss of quality. 
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Common file formats:

TIFF (Tagged Image File Format) Good for uncompressed 
digital images utilizing 24-bits of information per pixel
(16.7 million colors). Use TIFF when you want the highest
possible quality. 
file extension: .tif (eg: flower.tif)

JPEG (Joint Photographic Experts Group) Good for compressing
digital at varying compression ratios, utilizing 24-bits of
information per pixel (16.7 million colors). When file size
matters, JPEG compression can produce great quality and
small files. 
file extension: .jpg (eg: myfamily.jpg)

GIF (Graphic Interchange Format) designed for graphic 
elements such as type and logos. This format utilizes 8-bit
color (256 colors) which is perfect for images with large
areas of solid color with no gradients. 
file extension: .gif (eg: logo.gif)

FPX (FlashPix) A proprietary format developed by Kodak in 
conjunction with Microsoft, Hewlett-Packard, and Live
Picture. FPX is a multiple resolution image format that 
was designed for consumers and small office users. 
file extension: .fpx (eg: camerapix_1_03.fpx)

BMP (Bitmap) Windows native image file format.
file extension: .bmp (eg: desktop_pattern.bmp)

PICT (Quickdraw Picture) Mac native image file format.
file extension: .pict (eg: screenshot.pict)



You may choose to save your scanned photograph as a com-
pressed JPEG because you might be using it on a Web site or
sending it by e-mail. If you decide to use the JPEG format, you
may want to minimize compression or maximize compression
depending on how you plan to use the image. 

You may sometimes want to use a third popular compression
file format called GIF, which is more suitable for scanned 
artwork like company logos as opposed to photographs. 

Keep in mind that until you are familiar with Adobe
Photoshop, which will let you save your scan using any file 
format you choose, you will have to save your scanned image
in whatever format your scanner’s software will allow. 

Some scanners will let you choose the format after the scan,
others will require you to pick a format when you first set up
the software, and still others limit the formats in which they
can save images.

The important thing to remember is that you will need to save
your images in any one of several file formats and that these file
formats work the same way regardless of whether you are dealing
with a camera image or a scanned image. Saving your image as a
file is really the first basic output decision.

To learn even more about JPEGs, TIFFs and other file formats,
read the Digital Dialog articles found in the Student Lounge.
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Understanding and Creating 
File Names.

Most digital cameras automatically name individual files with
long strings of numbers that are rarely meaningful. Renaming
your digital camera files logically will mean easier searching
and retrieval. With scanned images, create a logical naming
system from the start since your scanner will let you pick the
name of the file. The type of images being organized will
probably dictate how a file is named. 

Example 1
If you are filing vacation photographs, perhaps a location/image
number and a date would be sufficient. For example,
“yosemite_001_05_00.tif” would designate an image taken in
Yosemite National Park (yosemite). It’s the first in a series of at
least 100 (001).  The month and year of capture was May, 2000
(05_00). Dates can be helpful when naming images, especially
if the subject has been photographed on multiple occasions. 

Once you’ve named your individual images you can group
them together in a folder. Image “yosemite_001_05_00.tif ”
might reside in a folder named “Vacation Yosemite 2000.” By
grouping all your Yosemite images in one folder you will be
able to find them quickly and easily. Just like an efficient filing
cabinet, accurate labeling and logical organization will make
your digital archiving trouble-free.

You can even make a folder to hold your folders. Perhaps 
all of your folders reside inside a master folder named “My
Vacations.” In the master folder you could store all of your
vacation images.
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My Vacations

Yellowstone
2000

Yosemite
2000

Grand 
Canyon
2000

yosemite_
001_05_00.tif

yosemite_
002_05_00.tif



Example 2
If you are filing photographs of inventory for your store,
cross-referencing an existing catalog number might make
sense for the new name of your file. This way, the name
remains consistent regardless of whether you are referring to
an actual product or the digital image of the product.

Example 3
Perhaps you will be scanning images for an article in a printed
magazine or for an online e-zine. For instance, when we scan
images for a Web article, let’s say on photographing birds, the
five images in the article might be called birda0903.jpg,
birdb0903.jpg, birdc0903.jpg, birdd0903.jpg and
birde0903.jpg. 

In this case, the file names tell us what article the image is used
for (bird), the placement in the article (a,b,c,d or e) which
would be a big help to your layout people, as well as the month
(September – 09) and the year (03).This may not seem very
important at first, but just imagine that it is five years from
now and you’ve amassed a huge collection of images from sixty
months of magazines. Being able to identify the pictures that
ran in a specific month would be very handy.

Example 4
On your Unit Two audio CD, we explain why you might want
to keep a master folder of your images in uncompressed TIFF
format and create all other files you need from those masters.
In this case, you might want to create a folder called Masters
and call each of the files in there something like
masteryosemite_001_05_00.tif. 

The point is that you need to think carefully about how to
keep track of your image files. It’s easier to create a logical
naming system now than trying to set one up after you have
hundreds or even thousands of files with names that no
longer seem relevant or useful.
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How to Create an Empty Folder.

WINDOWS: On a Windows-based machine, this can be done
in Windows Explorer. Simply choose File>New Folder and
give the folder a name. 

MAC: On a Mac, you choose File>New Folder and name 
the folder. 

Dragging images into the open folder (or right on top of the
folder icon) will deposit those files inside.

How to Re-name a File.

WINDOWS: On a Windows-based machine, you can
change the file name by clicking the right button of your
mouse on the file name in Windows Explorer or on your
Desktop. Select rename from the menu and type a new
name in. If your file name shows up with an extension, for
instance mypicture.jpg, remember not to change anything
after the period, since those three letters indicate what type
of file format the image is saved as. Changing the extension
could result in your file becoming corrupted.

MAC: On a Mac, renaming any file can be accomplished by
clicking once on the file title to highlight it, and then typing in
the new name. One small tip: If you are planning on giving
this file to someone using a Windows-based machine, we 
recommend that your Mac file name includes a period at the
end and three letters indicating the file format the image was
saved as. For instance, mypicture.jpg if the image was saved in
JPEG format or thisphoto.tif if it was saved as a TIFF.
Otherwise, the Windows-based user may not be able to 
open the file.
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Archiving/Storage.

Once your images are saved on your computer’s hard drive,
then the issue becomes where to store them and how to retrieve
them when you need them. We call this archiving. 

Archiving means different things to different people. Lots 
of people store their photographs in shoeboxes or drawers,
fumbling through hundreds of prints and negatives until they
find what they need. Others file their prints and negatives
carefully and methodically for easy access and viewing.
Whether you fall into either category (or are somewhere 
in-between) you will have to decide the best way to store your
digital images to suit your needs. 

Digital image storage has two stages: First, saving and cata-
loging your images on your hard drive, and second, backing up
your images onto another form of storage media. Let’s take a
look first at the options you have for storage.
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Hard Drive.

As we’ve explained above, while it is a good idea to store your
images on your hard drive, it is not a good idea to make your
hard drive the only place where you keep those files. Hard
drives do crash, so having your digital photos safely stored on
some type of backup media is essential. Furthermore, digital
image files can be quite large—it’s not unusual for a single
image to be 20, 30 or even 100 megabytes. Even the largest
hard drive will fill up quickly with files that large. So, always
make sure that you have copies of your files on a removable
form of media. 

That said, this does not mean that you don’t want to keep
your photos on your hard drive in some form or another. As
we will explain below, you may want to use software which
will allow you to easily identify, catalog, and retrieve your
digitized images when you need them. However, it is possible
to keep low-resolution small-size images on your system for
easy identification while keeping the larger “masters” on
removable storage. This way, you get the best of both worlds.

Floppy Disks.

A standard 3.5-inch disk can only handle 1.4 megabytes, which
means that the average digital scan or an image captured by a
megapixel digital camera will not fit on a single 3.5-inch disk.
While there are ways of compressing the information you store
so that you can fit more information on a single 3.5-inch “flop-
py,” compression doesn’t always work successfully and will ulti-
mately cause damage to the file. In addition, 3.5-inch disks are
prone to failure. They physically don’t stand up to rough han-
dling so it’s not unusual for these floppies to crack open or have
the metal tabs fall off rendering them useless. Like other forms
of magnetic media, they are also prone to damage from heat,
moisture and magnetic fields. Some computers don’t even come
with 3.5-inch drives any longer, so using these disks as storage
devices for your digital photos isn’t really a viable option.

Output Basics
Unit Two Lesson Eight

10dpcomplete
course New York Institute of Photography« contents »

3.5-inch floppy disks.



High Capacity Disks.

High capacity magnetic media are popular storage devices.
Many computers now ship with them as a standard built-in
accessory and you can add one to your system for under $100.
One example, a Zip drive works just like a 3.5-inch drive—you
save, copy, rename and remove files from Zip disks in exactly
the same way that you would use a floppy. Unlike a 3.5-inch
disk, that holds only 1.4 megabytes, high capacity disks come
in several sizes—100 MB, 250 MB, or 750 MB depending on
which type of drive you have purchased. Obviously, the advan-
tage of high capacity disks is that they can hold large amounts
of data and that means you can store a lot of your photos on a
single disk that costs less than $20. While these disks are simi-
lar to 3.5-inch disks in construction and prone to the same
types of damage from heat, moisture and magnetic fields, they
are less prone to damage from rough handling than floppies

since they are considerably thicker and much sturdier.

Recordable CDs.

An increasingly popular form of digital image back-up is the
recordable Compact Disc or CD. In order to write information
to a CD, you need a CD “burner.” CD burners are 
different than the CD–ROM players that come installed on
almost all computers today. CD–ROM drives are designed
only to read information. Recordable CDs are recorded, or
“burned,” with a laser, which creates “pits” (indentations) and
“lands” (reflective areas) that correspond to digital information.
Easy-to-use software coupled with low prices have made CD
output perfect for storing large amounts of digital information.
At 650 MB, CDs can store 6 1⁄2 times more information than a 
standard high capacity disk. 

There are 2 main types of recordable CD media: CD-R and
CD-RW. There are some significant differences between the
two. CD–R media cannot be erased and re-written. CD-RW
can be erased and re-written over and over again making it a
much more flexible storage media. CD-R, however, is preferred
by many for archival back up because it can’t be erased and is
also a good deal cheaper than CD-RW. The choice of which to
use is strictly a personal one.
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DVD.

Another form of digital storage is the DVD burner. DVD
backup is very similar to the CD burning process, the main
difference being that DVD lasers burn at varying intensities
allowing more information to be stored on a disc. Rapidly
dropping prices, coupled with the ability to store from 5 to 9
gigabytes of information, fast transfer speeds, and promises of
long life make this storage medium hard to ignore. 

Storage Media Considerations.

Now that we’ve explained some of the popular forms of
removable storage, how do you decide what type of storage

is best for your needs? Here are some tips on evaluating
these options:

Capacity: The ability to store more images is important for
efficient storage. You should evaluate which type of storage
device to buy based on its capacity. However, you may decide
to buy several different types of storage devices. It’s not unusual
for instance, to have a computer that has both a 
CD-RW drive and a Zip drive. If you do have both types of
drives, you’ll want to evaluate which storage device to use on a
case–by–case basis. For example, you may store your image
files on CD-RW but you may choose to send a disk to your
service bureau because it’s quicker and easier to put a few
images on a disk as opposed to the effort required to burn a
CD.

Reliability: How does a particular type of media storage
hold up under adverse conditions? Manufacturers do subject
their media products to accelerated aging tests and you
should be able to track down some information on the
longevity of files saved on a specific brand of storage.
However, the bottom line is that these devices haven’t been
around long enough for anyone to guarantee that they will
survive 20, 30 or even 50 years in the future. All technology
fails at some point, so 
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careful attention to making multiple backups will eliminate
the possibility of a catastrophic loss. It is also not a bad idea
to check magnetic types of media like floppies and high
capacity disks periodically to make sure that they are still
functional and perhaps copy the files onto new media every
few years or so.

Standardization: Try to choose a medium that is nearing its
peak popularity. This is especially important if you plan on
sharing your image files with other people or companies. The
newest technology may not become widely accepted and the
older products may be headed for obsolescence. The most
important thing is to be aware of obsolescence when it comes
to hardware, formats, and media. Be aware of shifts in the
industry and don’t get caught with a bunch of files that you
can’t read because the storage devices no longer exist. For
instance, when was the last time you saw 51⁄4–inch disk drive in
a modern computer? As we’ve already noted, there are more
and more computers being manufactured without any floppy
disk drive which was a standard item just a few years ago. 

Cost Per Unit: This formula will help you determine how
much you’re paying per storage unit, allowing you to compare a
variety of media for cost efficiency. Let’s look at a few examples:

A standard Zip disk can sell for about $10.00, and can store up
to 100MB of digital information per disk, so:

100MB divided by $10.00 = $1.00/ MB. 

The cost per MB for a Zip disk is $1.00.

A CD-R disc can sell for about $1.00 if you buy them in
quantity. A CD-R disc can hold up to 650MB of digital
information, so:

650MB divided by $1.00 = .0015 cents per MB 
(that’s less than a penny per megabyte).

A CD-RW disc that sells for $2.00 means you’ll be paying .003
cents per megabyte of information.

On a cost-per-unit basis, you can plainly see why CD media
makes sense when it comes to storing large amounts of
digital information. 

Please realize that these figures are an approximation. While a
100 MB disk can theoretically hold 100MB, it starts to get
crowded once you pack 90MB on to it. Remember that some
space is taken up by directories and other internal information.
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In the same way, the CD-R or CD-RW is about full when
you’ve loaded 620MB of your image content.

So, why would you ever you use a high capacity disk based on this
scenario?

The simple answer is convenience, which is another major
storage consideration.

Popularity: The popularity of magnetic media technology
ensures that your disks can be read by a wide variety of com-
puter users since they are a standard feature in a lot of
machines. Any serious service bureau will be able to read a high
capacity disk, so they are great for transporting files for output.

Transfer rate: Transfer rates are a way of evaluating how fast
data will be copied from your hard drive onto the storage media.
These rates vary widely. Speed is a big factor when it comes to
making copies. Fast transfer rates will make backup easier and
faster and, as a result, more likely to take place. Burning a CD or
DVD can be a slower and more labor-intensive operation com-
pared to making a disk backup. In reality, a measured use of both
media will help streamline your digital workflow. Magnetic
media is great for short-term storage and CDs and DVDs for the
long haul.

One last tip: Do not buy cheap media of any kind. Using
“no-name” brands is an invitation for problems. Stick with
the current respected leaders in the storage media industry
that all offer a wide variety of different types of storage
including 3.5 inch disks, high capacity disks, CD-R, CD-RW,
and DVD-R.

In the end, if you use a combination of long-life media, a
proper storage environment, proper handling, error-
detection, and you make a sufficient number of backups, 
you will ensure having a long-lived and safe digital library of
your photographs.
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Storage Workflow From Your Camera.

If you are working with a digital camera, you will want to
transfer your images from the camera to a hard drive on your
computer using the camera software or a card reader of some
sort. You don’t want to leave your images on the camera’s
storage media, because memory cards and other “digital film”
types are simply not as durable as hard drives or CDs. Once
you have transferred your images to your hard drive, be sure
to try to open your downloaded images immediately to check
that the files were not corrupted during the download
process. If any problems occurred in the transfer process, you
don’t want to find out after you’ve deleted the images from
your camera. Always confirm that the transfer was successful. 

At this point, you may want to duplicate those files on a 
removable disk. This is a simple precaution that acts as your
safety net if your computer’s hard drive suddenly decides to
crash. Now with two backups confidently completed, one on
your hard drive and the other on another form of storage
media, you can safely delete the images from the camera’s 
memory card.

Storage Workflow From Your Scanner.

Working with scanned images is similar. Depending on your
scanner’s software, your images will either automatically be
saved by the scanner onto your hard drive or will wait in your
computer’s RAM memory until you give the scan a file name
and designate where to save it. We recommend that you should
always save your scanned images first on your hard drive and
then copy them to a removable storage device. 

It is best that you don’t try to save your scan directly to a remov-
able disk. That’s because the image may be larger than your 
removable disk will allow, or the process may require too much
RAM, thereby resulting in the system crashing. 

In addition, it’s a good idea to save your scan in a non-
compressed format like TIFF before you attempt to correct the
scan in the digital darkroom. This way, if you are not happy
with the results of your corrections, you have the untouched
file safely stored inside your computer. 

Furthermore, if the scan has not been saved, it is held 
temporarily in your computer’s RAM. By saving your image to
your hard drive you are essentially clearing the RAM for more
important operations, like making another scan.
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Organizing Your Images.

Database Technology for Archiving and Retrieval.

Once you start using a digital camera and/or start scanning
your photographs, you are going to find yourself suddenly
overwhelmed with a large number of digital image files. The
question then becomes: How best to keep track of what you
have and how to find a particular image when you need it? 
Just imagine receiving a call from a client whose wedding you
photographed two years ago or a stock photo agency looking
for that great picture of an exploding volcano you know you
took. Can you put your hands on those photographs? 

Looking for a digital image in this scenario can be just as 
frustrating as trying to put your hands on the original slides or
negatives in your filing system, especially if you don’t have a
system in place to easily locate the files. 

The truth of the matter is that one of the reasons to have 
digital files of all your images is so you can locate the picture
when you need it. It should be easier than finding the original
hard copy photograph. But as you go along and accumulate
more images, you’ll find that the folders you set up earlier
won’t do the entire job.

In the early days of digital management, images were organized
with customized database software. The task of processing, organ-
izing and delivering digital images was left to the high-level com-
puter programmer who often had to convert software that was
meant to handle text-based information. Today, there are many
off-the-shelf software packages that will let you catalog, search
and retrieve your photographic data files quickly and intuitively.
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Let’s examine some of the options available.

The simplest form of this type of software lets you view the
contents of a folder and see what the files look like in 
thumbnail form. Macintosh computers have the ability to 
see thumbnails of all their files automatically, as do many
Windows-based machines.

However, if you have a lot of digitized photographs, you may
find that you need to move up to a more sophisticated data-
base program that can easily handle the hundreds, perhaps
thousands, of image files stored both on your hard drive and
in multiple disks. Database programs that handle images
work similar to database programs that many office workers
are familiar with, like the type used by your doctor or your
local Motor Vehicles department. The major difference is
that they let you see the photographs.

Extensis Portfolio is an example of database technology that
everyone can use. Fairly simple to use, Portfolio creates a data-
base of digital files including thumbnail images that are easily
searchable. Portfolio also has the ability to attach keywords for
custom organization of your files. In simple terms, Portfolio 
creates a “table of contents” of any group of files.

Extensis Portfolio comes in several different versions including
software that lets you manage images on an office computer
network or on the Web. Obviously, which version you’ll need
will depend on the amount of images you expect to have and
the sophistication you require. 

Extensis is also not the only manufacturer of this type of 
software. Other brands are ImageAXS Pro and Cradoc Photo
Management System. You can also find shareware and freeware
on the Web. Here are some considerations you should take
into account when deciding which type of archiving software
will work best for you.
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Database Considerations.

What will your image collection consist of? Is it for business or
personal use? 

One photographer or a group? Different archiving software
may suit one need better than another.

How big is your current collection? A small collection may be
well served by a word processing program, your computer’s file
managment system and some careful filing. A large file will be
more manageable with a database program like the ones we’ve
mentioned. 

How fast do you expect it to grow? Consider the maximum
and assume that your photo collection is going to grow quickly.
Multiple copies of one image may include a digital master, an
edited version, a creatively manipulated version. One image
can quickly become three. 

Do you need the database that can be used by many people?
A program like Portfolio produces files that can be read on
different platforms including Macs, PCs and Unix
machines. If you don’t know who your audience is, this 
feature will be invaluable.
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Is security an issue? Consider who may have access to your
valuable image assets. Stealing images, whole or in part, has
become very popular with the advent of digital imaging.

Will you need the software to coordinate with your existing
hard copy slide, print and negative filing system? For
instance, should the software you use have the capability to
create labels?

Would it be helpful for the software to have the ability to 
create printouts of thumbnail index pages or create a Web site
portfolio you could show to clients? Not everyone likes to (or
is able to) stare at a computer monitor for long periods of
time. Printouts of small low-resolution images can be a great
way to cull through large amounts of image files.

We can’t recommend a single product, since the needs of
different students vary widely. However, if you answer the
questions we’ve listed above, and check the features of each
of the different products available, you’ll find the software
that’s right for you.
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Outputting Your Digital Images.

As we’ve discussed, output doesn’t just mean creating a digital
file. Output also refers to being able to print out your images
on paper. Creating prints from your digital photos is perhaps
the most popular form of output. You have lots of different
options when it comes to being able to get a print from your
image files—you can print them yourself on either an inkjet
printer, dye sublimation printer or at a self-service kiosk, send
them out to a service bureau or lab, or even upload them onto
the Web for output. As technology advances, there will be
more and more ways for you to output your digital images into
print form. Let’s discuss what some of today’s choices for print
output entail.

Creating prints of your digital files really falls into two distinct
categories. Outputting the images yourself on a machine you
own in your home or sending the digital files to someone else
for output on paper, film, or even t-shirts, mugs and just about
anything else that will accept a photographic image.

Printing Images Yourself.

Creating digital prints yourself at home is getting easier and 
easier. At this time, there are three different types of printers that
you might purchase to print your digital files—inkjet printers,
photo-quality inkjet printers and dye sublimation printers.
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Inkjet Printers.

Inkjet printers fall into two distinct types, traditional inkjet
printers and photo-quality inkjet printers specifically designed
for photographic output. Inkjet printers work by firing tiny
droplets of ink at tremendously high speeds through nozzles
mounted on a print head. The print head moves horizontally
across a sheet of paper as the paper itself moves vertically through
the machine. On some machines, in particular Hewlett–Packard
and Canon inkjets, the ink that is squirted through these nozzles
is first heated to very high temperatures, causing the ink to 
bubble. When the nozzles spray these bubbles, they burst against
the sheet of paper. Other manufacturers, like Epson, use a
method where a piezo crystal behind the print head is electrically
charged and that causes the ink to spray through the nozzles.
This method allows for smaller droplets of ink and more nozzles.
How many nozzles a print head contains is directly proportional
to the resolution of the inkjet printer. 

Inkjet resolution is usually described as dpi (dots per inch).
The dots produced by an inkjet printer are so small that 3 or 4
drops will fit within the space of a pixel. That’s why you’ll see
printers with a resolution specification of 720 x 1440 dpi or
more. If these models require a pixel resolution input of 240
ppi to produce optimum output, we can ascertain that they

can produce three drops of ink per pixel. Let’s see why:

720 dpi divided by 240 ppi = 3 dots-per-pixel

Inkjet dots are so small that when they are combined they
give the illusion of a continuous-tone image, just like a 
photographic print.

We’ve mentioned it before but we feel it’s important to under-
stand the difference between dpi and ppi. Go to the Study Hall
for a brief discussion on the differences between the two.

Photo-Quality Inkjet Printers = More DPI.

The major difference between traditional inkjet printers and
those designed specifically for photo-quality output has to do
with the resolution of the printer and the number of droplets
of ink that the printer can spray per inch. The more droplets,
and the smaller and finer these drops of ink are, the better the
resulting print will be. For that reason, owning an inkjet model
specifically designed for photo output is preferable to a tradi-
tional inkjet printer if you wish to create photo-quality output.
Photo-quality ink jet printers have dropped dramatically in
price in the last few years, so this is a very viable alternative for
most people. As easy as the printing process is, there are a
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number of other factors that can have an impact on how good
your inkjet prints will be:

Paper Considerations.

Paper for your inkjet comes in variety of grades, sizes and 
surfaces depending on what type of look you require. In 
addition, you can buy paper made by third-party manufac-
turers as opposed to the manufacturer of your inkjet printer.
Read the article on Inkjets and Inkjet Paper on your Unit
One WebCenter to learn more about the different choices in
both inkjets and paper. However, if you wish to get the high-
est photo-quality output possible, it is best to stick with the
paper designated as “Photo Paper” put out by your manufac-
turer. “Photo Paper” is usually a grade above paper designated
as “Photo-Quality.” It is important to use paper designed for
photo-quality output. The hard smooth surface of these
papers keeps the ink on the surface which helps to create
sharp images. 

Although Photo Paper costs more, it’s worth the price if you’re
looking for the best quality. Depending on your printer, which
paper you choose may also have an impact on the longevity of
the print that you create.

Ink Considerations.

Your inkjet printer manufacturer will give you specific recom-
mendations for which ink cartridges that you need to buy for
your printer. Depending on the model inkjet printer you own,
you may need to buy two cartridges—black and a combined
color cartridge (usually cyan, magenta, yellow) or separate 
cartridges for each color plus black. 
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Some inkjet printers allow the use of special archival inks.
Archival inks can mean the difference between long-lasting
color or a faded print. However, archival inks may not be
made by your manufacturer. There are third-party inks 
available on the market, including archival inks, but it is very
important to make sure that these third-party inks are rated
for your specific model printer. You can destroy the print
heads on your printer by using the wrong third-party ink,
and void the warranty on the machine to boot. Always be
cautious about using any ink that isn’t made by the company
that manufactured your printer.

Longevity.

How long your inkjet print will last is a major decision to
consider before buying a printer. With the exception of a few
models, many of the inkjet printers on the market create
prints that will last anywhere from six months to several years
before the image starts to degrade. While it is true that one
advantage to digital photography is that you can always create
another print, you will have a lot of disgruntled customers if
you sell them an inkjet print of their wedding or of their
children that starts to change color after a few months. So, if
you plan on selling inkjet prints that you’ve made, you need
to consider how long they’ll last. 

Many manufacturers are now offering archival options for
their printers. 

Epson, for instance, now has inkjet printers on the market that
they claim can create prints that will last as long as traditional
photographic color prints. Keep in mind, of course, that this
claim is through testing under simulated conditions—inkjets
haven’t been around long enough to truly know just how long
a particular print made by a particular manufacturer will last.
In addition, how the print is stored will also have consequences
on its longevity. Ozone and other atmospheric conditions like
smoky environments and high humidity can cause color shifts.
Storing your inkjet prints in a sunlit room can cause the prints
to fade. Inkjet prints are not waterproof either, so be careful
with them near liquids.

Resolution Considerations.

A resolution setting of 200-300 ppi will provide the 
best output on a wide variety of inkjet printers today.
Remember, that ppi differs from a printer’s dpi specifica-
tions. As we discuss on your Unit Two audio CD, finding
out exactly what the recommended ppi is for your printer is
not an easy task, but well worth knowing. For instance, you
can save considerable amounts of time and create larger
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images if the optimum resolution of your printer is 240 ppi
as opposed to 300 ppi.

Read the articles on inkjet printers and inkjet paper in your
Unit One WebCenter to find out more about what models
are available.

Dye Sublimation Printers.

Another type of printer available for you to buy for your home
is the dye sublimation printer. Since everything in the comput-
er world needs a name in computer lingo, these are usually
called “dye sub” printers. 

Dye sub printers differ from inkjet printers in a number of
ways. Let’s start with the sublimation process itself. A dye sub
printer’s head heats up a ribbon which produces a gas that
hardens onto the paper. This process of converting a solid into
a gas is called sublimation. The ribbon, also called a transfer
roll, is really a plastic film that contains cyan, magenta, yellow
and black inks. The heat of the print head diffuses the inks
onto the paper from the ribbon. How hot the print head gets
controls both the density and the intensity of each particular
dot of ink that appears on the paper. The paper used in dye 
sub printers is special paper that is designed to accept these

vaporized inks. A dye sub printer’s tones are smoother and
more continuous than those of inkjet printers because techni-
cally dye sub printers don’t use dots. As a result the prints pro-
duced appear to be more like traditional photo prints.
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Dye Sub Costs More.

While dye sub printers can create better looking images than
inkjet printers, they do so at a higher cost. The consumables—
paper and the transfer roll of ink—can be considerably more
expensive than inkjet consumables. You will also not have the
varieties of paper and ink that you find with inkjet printers and
you will most likely be limited to what the manufacturer of
your dye sub printer makes. 

The advantage to dye sub printers is that they create good
looking prints at lower resolution and can do so faster than
inkjet printers. They are also reported to create prints that are
considerably more archival than standard inkjet prints. 

One feature found on some dye sub printers is the ability to
accept and print from camera storage media directly. Olympus
makes a dye sublimation printer, for example, that is designed
to accept and print directly from SmartMedia, Compact Flash
and even Sony’s Memory Stick, eliminating the need to use a
computer. While this may make printing easier for digital
beginners, it ultimately reduces your control over the image. If
you’re serious about digital imaging you’ll quickly outgrow this
feature when you see what’s possible with digital darkroom.
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Making a Print.

In this discussion, we refer to the term digital image-editing
software. Adobe Photoshop falls under this category, but so do
a host of other programs. While all of this software performs
similar tasks, the methods may be somewhat different. In Unit
Three, once we start discussing Photoshop, the explanations of
these tasks will become much more specific and meaningful.
For now, understand that your application may work slightly
differently. All of these topics will be covered again within the
context of a common image-editing program—Adobe
Photoshop.

Before we continue with our discussion of other types of 
output, let’s run through the actual process of making a print
using a typical desktop printer.

Basically, the process of creating a print is not very different
than printing a word processing document. Make sure that
your printer is on, then:

1.  Install your printer’s driver software if you have not
already done so. Your printer comes with driver software that
operates your printer. On a Mac or a Window’s based
machine, you install the printer driver by simply inserting the
CD and running the Installer program. 

2.  Turn your printer on and start your digital imaging/editing
program. Later on in your Course, we’ll show you step by step
how to create a print using Photoshop as well as how to create
specialized types of prints like duotones. For now, you’ll want
to start whatever image-editing program came with either
your scanner, digital camera, or printer. Remember, this type
of program is different from your scanner’s software, your
camera’s download software or your printer’s driver software.

3.  Open an image. Using your image-editing software, open
up the file containing the image that you wish to print. What
type of image will work best? For the most part, you will
want to print from either a JPEG, or TIFF or whatever file
your camera or scanner has used to store your image.
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4.  Check the resolution and print size. Your software should
tell you what size image you have and what resolution it is in
as well as what size output you can get depending on the 
resolution. Remember, unless you know what the optimum
resolution is for your printer, you will want to use a 300 pixel
per inch image. 

The best way to determine that your image has the correct
resolution for your output method is with the Image Size
dialog box. Most digital image editing programs have one. 

For those of you who have Photoshop already, here is how the
Image Size command works. Go to the menu command
Image>Image Size.

This command brings up the Image Size dialog box.

The Resample Image check box in the lower left hand 
corner of the Image Size dialog box is checked by default.
By leaving this box checked we are asking Photoshop to
interpolate pixels when we adjust either the physical size 
of the image or the resolution. 

By un–checking the Resample Image box you are free to change
the resolution to the suitable pixel-per-inch value necessary for
your printer. In this un–checked mode, no pixels are thrown
away or added, they are simply reconfigured to the pixel per
inch setting that you need. For instance, many digital cameras
produce files at a default setting of 75 ppi, which makes for a
nice big image on screen, however when you want to print your
image, the resolution must be adjusted to 300 ppi in order for it
to print cleanly. While adjusting the resolution may reduce 
the physical dimensions of your printed image, you are also
insuring that the quality of your output is as good as it can be.
If you find that your size doesn't meet your needs you can
either scan your image again at a higher resolution, or increase
the quality setting on your camera.

If you don’t have Photoshop yet, or you can’t find the Image
Size commands in the software you do have, you can always
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download a demo from Adobe’s Web site to begin to learn how
this important function works.

5.  Choose the Print Command. Go to Menu Command
File>Print to open your printer dialog box. 

6.  Set the print options. Depending on your printer, you may
be able to tell it what type of paper you are printing on. You
may also be able to select quality settings like photo-quality or
indicate resolution, orient your paper so that you can print
sideways on a sheet of paper (landscape mode), choose paper
size (large sheets of paper or small sheets like 4x6 inch), even
scale a large size file so that it prints on a single sheet of paper.
You should read your printer’s manual carefully so that you
understand exactly what settings you have available and how
they work.

7.  Choose Print. Your printer should now go ahead and
create a print based on the specifications that you put into
your printer’s software.

Note: If you have more than one printer’s driver software
installed, you will need to make sure that the printer listed is the
one that you want to be using to make your print.

On a Windows–based machine, this is accomplished by
choosing the Print–Command (File>Print) and, in the print
dialog box, indicating your printer.

On a Mac, click on the Apple Menu (it’s the little apple in
the upper left corner of your desktop) and find the Chooser.
The Chooser dialog will contain two panels, find your printer
on the left and click once to highlight it. You’ll then be
prompted to choose a printer port. Choose the appropriate
port (printer or modem) and you’re done.
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Troubleshooting.

If you find that you are getting prints that don’t look good,
there are a number of common printer problems that can
cause this.

Resolution is Set Too High.

If the optimum resolution for your printer is 300 ppi and you
send a 600 ppi image to your printer, a couple of things can
happen:

1.  Your printer will slow down significantly due to the fact
that it has to process more information than is necessary.

2.  Your image quality may actually decrease because your
printer will have to eliminate image information to produce
the print. 

3.  The physical size of the print may be smaller than what
you expect. 
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Resolution is Set Too Low.

If the optimum resolution for your printer is 300 ppi and you
send a 75 ppi image to your printer, a couple of things can
happen:

1.  At 75ppi, image pixels will be quite visible. 

2.  Smooth lines will begin to “stair-step.” 

3.  Fine detail will be lost.   

4.  Overall quality will decrease.

5.  Physical size of print may be larger than expected.

It’s up to you to be sure that the resolution is set correctly 
before you send it to print. If you are unsure about resolution
necessary for your printer, use the industry-accepted standard of
300 ppi. A better choice is to consult with the manufacturer of
your equipment. Be sure to check out the additional informa-
tion on resolution in the Unit Two Study Hall. When we begin
to use Photoshop in Unit Three, we’ll all be on the same page
when it comes to image resolution adjustments.
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Landscape/Portrait Setting is Wrong.

When sending an image to print be sure to check the page
set-up dialog box for the proper orientation of the paper. If
your image was shot horizontally (landscape mode) and the
printer is set up for a vertical print (portrait mode) a couple
of things can happen:

1.  Your printer may inform you that some clipping will
occur when printing. Clipping in this case means your image
will be cropped. 

2.  Your printer may reduce your print to fit on the page
yielding a print which is smaller than you expect.

3.  Your printer may simply go ahead and print your image
cutting off portions of it. If you are printing a landscape
picture in portrait mode, then it is easy to fix. Simply
change the orientation setting. If that is not the problem,
then you may need to change the scaling.

Physical Size/Scaling.

1.  If you find that your image is printing on more than one
sheet of paper or you are only getting a small portion of the
picture, then your image is physically too large. You may be
able to change the resolution and thereby change the size of the
printed image. However, you can also check the box in your
printer’s option menu that says shrink to fit. This will let you
print an oversized image on a single sheet of paper without
changing the resolution. Unfortunately, this method will allow
the printer to determine which pixel information is discarded
in order to make the image fit on the paper. This inevitably
leads to lower quality.

2.  If you find that your image is printing too small, check the
resolution and make sure that it is correct for the size print that
you need. If there aren’t enough pixels to satisfy the output,
consider re-scanning your art at a higher resolution.
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Paper and Inks.

Remember that your prints will only be as good as the paper
that you use. You can see this if you print a photograph
using either Photo Paper or Photo-Quality paper and then
print the same image using plain paper. You will notice a
considerable difference in quality. However, using another
manufacturer’s paper or ink may also have a detrimental
effect on the quality of the image. So, if you are not satisfied
with what you are getting and you are using a third-party
product, this might be the cause.

Most printers seem to behave themselves when it comes to
laying down a nice, clean image on paper. However, when
you start to make lots of prints, or use unusual paper 
surfaces, or experiment with special inks, you may run into
problems. Check your printer’s manual for the proper 
cleaning procedure for your model. Also, as we noted before,
special inks can cause special problems. Follow all the clean-
ing instructions to the letter.

Outside Printing Services.

There will be times when you won’t want to create your own
inkjet prints. Perhaps you don’t have a printer, can’t create the
size output that you need, or don’t have the time to handle the
number of prints that you need to make. The reasons why you
might want to take your digital files to an outside service for
output are numerous. In fact, we can guarantee that at some
point, no matter what kind of printer you own, you will want
to produce a print by some other means. Let’s discuss what
other options are available for print output:

Online Services––Camera to Computer to Print.

Digital image processing has been taken to a new level with
online services. Upload your images to an online lab service
and you can get fast digital prints for a reasonable amount of
money. The quality is generally pretty good. 

Why would you want to use an online print lab? Convenience
and cost for starters. Depending on the cost for paper and ink
for your printer, and the time it would take you to make two
or three dozen prints, you may find that paying 30-40 cents
per print from an online lab is cost effective. Using an online
lab is also very convenient. For instance, if you shoot mostly
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slide film, you may find that sending your slides out to have a
Photo CD made and then uploading them to an online lab
will allow you to get good quality prints that are better, faster
and certainly less expensive than having the slides printed by a
traditional lab. That’s because slides generally require inter-
negatives in order to produce a standard print. An inter-
negative is a film negative of a film positive. Because inter-
negatives require film, chemicals, an imaging device and a
photo technician to produce, they are expensive. 

Tip: If you upload your images to an online service, make sure
that they are 300 ppi in order to ensure best quality. You’ll also
find the upload is a lot faster if you have access to a cable
modem or high speed connection rather than a 56K modem.

Self-Serve Kiosk. 

Another possible mode of direct output is the self-serve kiosk.
Photo-giant Kodak has produced one such machine, called 
the Kodak Picture Maker. It’s found in many labs across the
country and allows you to bring an image from a floppy disk
or a Photo CD and make a print from the file by yourself.
Other manufacturers offer these types of kiosks as well and 
you can find them in places like Kinko’s, department stores and
drug stores.
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Service Bureaus and Digital Labs.

As we mentioned in Unit One, many traditional labs have gone
digital when it comes to output. Digital labs or service bureaus
are popping up all over the place, providing yet another way to
produce prints from your digital images. These labs and service
bureaus usually provide a variety of different types of output.
They can make color laser prints, oversized prints like posters
and signs, or you can have your digital file output as film to 
create a negative or transparency of your image. These types of
labs also provide many high-end options that you might need if
you are going to incorporate your images into professionally
printed pieces for instance. Most of these labs can usually 
handle high-end drum scans, Picture and Photo CDs and other
imaging services as well. It is a good idea to scout around your
area to find out what service bureaus and labs are available and
what services they offer so that you know who to go to when
you suddenly find yourself needing something you can’t do in
your own digital darkroom.

Always check with your vendor for their best specifications for
file delivery. By providing them with an optimized file, you can
help to guarantee satisfactory results. If the file provided is
saved in a format they can’t read or if the resolution is too high
or too low the print quality will suffer.

When submitting images to a service bureau you may be asked
to fill out a form which will follow your job throughout the
production. A typical production order from a service bureau
might include some of the items in the sample order form on
the previous page.

A good service bureau can recommend the best format or
resolution needed to produce optimum output based on
their equipment and your needs. Ask questions if you’re not
sure. A good service bureau only wants to do a job once. A
job that has not been prepared properly means lost time and
possibly bad output. Sometimes a service bureau will charge

Output Basics
Unit Two Lesson Eight

34dpcomplete
course New York Institute of Photography« contents »

©Kodak



Output Basics
Unit Two Lesson Eight

35dpcomplete
course New York Institute of Photography« contents »

How are you delivering
your files? Zip disk or 

floppy disk or CD?
NOTE: Be sure all media
is returned with job. This

is an easy way to lose a
disk.

Very important, spell the
file names exactly, espe-
cially if you have multiple
documents on the same
disk You don’t want them
to print the wrong file.

If a file was created in
Photoshop and is being

delivered as .psd file,
you will want to be sure
your service bureau has

the software necessary to
work with the file.

TIFF, JPEG, BMP, etc.
your file should have
the appropriate three
letter extension.  
(Example: .tif; .jpg; 
or .bmp)

Iris print, dye sublima-
tion, inkjet, Giclee, film
(35mm or 4x5). A good
service bureau will offer
many different output
options. 

Sample Order Form.



extra to prepare a file for output if it has not been done 
correctly on the file you submit. So be sure to ask your 
questions before you send your job out.

With this lesson on basic output, plus the lessons on digital
acquisition, we’ve come full circle. You can now start to
appreciate how input affects output in the digital environ-
ment. Careful consideration of how you want to use your
images has a direct correlation to the techniques you need
to use to capture them.

Conclusion.

In Lesson Nine, we’re going to turn our attention to content,
meaning, and aesthetics of the photos you take. We’ll return to
advanced output issues in Unit Five.
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